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9. OrCAD Capture. 

В главе « 3. Работа со схемой.» мы рассмотрели несколько примеров неочевидных 

ошибок, которые могут прийти из-за неграмотно составленной принципиальной схемы. 

Это – ошибки подключения питания и земли, а также ошибки, связанные с неправильной 

нумерацией выводов компонентов. Увы, в подавляющем большинстве случаев, инженер-

электронщик и разводчик платы – это две разные специальности. Собственно, так оно, мо-

жет, и должно быть, но выясняется, что первый совершенно не понимает проблем второго. 

90% рисуют схемы в OrCAD, тщательно соблюдая нумерацию ножек микросхем. При этом 

считается вполне естественным опускать нумерацию выводов дискретных компонентов: 

диодов, полярных конденсаторов, транзисторов и т.д.. 

То же самое относится к выводам питания микросхем. Вероятно, люди думают, что 

разводчик сам догадается, что цепь VCC – это, на самом деле, две разные цепи: +3.3V и +5V. 

C божьей помощью, он подключит их куда надо. 

Если Вы разрабатываете схемы, помните, пожалуйста, о таких «мелочах». Иначе, в 

худшем случае, плату придѐтся переделывать. И это будет, вне всяких сомнений, Ваша вина. 

Если же Вы занимаетесь разводкой, то обязательно должны проверить поступившую к 

Вам схему. Лучше сделать это вначале, чем выяснять потом отношения с заказчиком, кото-

рый, естественно, всю вину попытается свалить на Вас. 

Впрочем, возможно, Вы работаете в небольшой фирме и являетесь и тем и другим в 

одном лице. Ну что ж! Это – самый безопасный вариант. 

Самый плохой случай, когда фирма, из соображений секретности, передаѐт разводчику 

только netlist. Без схемы. Такое бывает очень часто. Работа затягивается надолго, как прави-

ло, из-за многочисленных исправлений и последующих тщательных проверок. 

Проблема очень серьѐзная! Будущие электронщики изучают электронику и выходят 

грамотными специалистами. Но рано или поздно, проект, который был на бумаге, приходит-

ся воплощать, что называется, «в железе». Вот тут-то и выясняется, что рисунок схемы – это 

далеко ещѐ не сама схема. Правильно подготовленный проект отличается от своей распечат-

ки также, как рисунок компьютера от самого компьютера. 

Конечно, все платы будут нарисованы, а ошибки исправлены. Но на это будет потраче-

но время, которого не вернѐшь, будут потрачены нервы, которых жаль. Поэтому в этой главе 

мы рассмотрим некоторые аспекты работы в Cadence OrCAD Capture CIS, как, пожалуй, од-

ной из самых распространѐнных сред проектирования принципиальных схем. Мы рассмот-

рим ряд примеров грамотного использования программы. Увидим, как Layout Plus поможет 

нам находить ошибки в схеме. Как сделать проект компактнее. Раздел завершится описанием 
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Я предполагаю, что Вы, без сомнения, обладаете определѐнными навыками работы в 

Capture, поэтому данная глава, в отличие от Layout Plus – основной темы этой книги – будет 

начинаться не с азов, а сразу с некоторого уровня. 

Рассматривать будем 16-ю версию пакета, в состав которой включена опция CIS. Or-

CAD Capture в этой версии носит название Design Entry CIS. 

9.1. Net name. 

Прежде всего, необходимо определить, что в Capture мы разрабатываем не схему, а 

проект. Проект состоит из дизайна (Design), библиотек, отчѐтов, файлов для связи с другими 

программами (netlist) и может включать в себя ссылки на другие проекты. 

Дизайн, в свою очередь, состоит из схем (Schematics), а схемы располагаются на лис-

тах (Pages). 

Это – общеизвестная информация. По OrCAD Capture существует великое множество 

книг и описаний. Мне бы не хотелось повторяться. Вместо этого рассмотрим практический 

пример. 

Создайте новый проект и нарисуйте вот такую простую схему (рис.  9-1): 

 
рис.  9-1 

Структура проекта очень проста (рис.  9-2). Дизайн состоит из одной схемы MAIN, 

схема располагается на одном листе PAGE1. На схеме присутствуют два коннектора из биб-

лиотеки CONNECTOR.OLB и символы земли, которые носят название GND_T. Последние 

взяты из библиотеки ALTERA_MY.OLB. 

 
рис.  9-2 

На схеме имеются две цепи, соединяющие разъѐмы. Мы дали им имена CONN1 и GND. 

Сделайте netlist и передайте данные в Layout Plus. Вот что получится (рис.  9-3): 

                                                
113

 Component Information System. 
114 Internet Component Assistant. 
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рис.  9-3 

Теперь проверьте таблицу Nets в Layout (рис.  9-4): 

 
рис.  9-4 

Странно. Мы ожидали увидеть цепь GND, а не GND_T, не правда ли? Вернѐмся в Cap-

ture, дважды щѐлкнем по цепи GND и откроем еѐ свойства (рис.  9-5). 

 
рис.  9-5 

Если цепь подключается к символу земли или питания, то она получает имя этого сим-

вола. То же самое относится к символам иерархических соединений Port, о чѐм поговорим 

ниже. 

 
рис.  9-6 

 
рис.  9-7 

Однако, с помощью инструмента Place Net Alias цепи было назначено другое имя, и 

его можно увидеть, щѐлкнув по ячейке Name (рис.  9-5). На стр. 161 подобный пример разби-

рался. Цепь может иметь больше одного имени, что ошибкой не является. 

Выберите имя GND и щѐлкните по кнопке Apply. Появится дополнительный столбец 

Net Name, указывающий на то, что имя цепи было задано вручную. 

Обновите netlist, и передайте данные в Layout. Обратите внимание на строчку в AutoE-

CO Report: 
Net GND_T renamed to GND 

В Layout Plus откройте таблицу Nets и убедитесь, что цепь поменяла имя (рис.  9-8). 
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рис.  9-8 

Таким образом, независимо от того с какой PCB-программой Вы работаете – Layout 

Plus, Allegro или иной – если не удаѐтся найти цепь на плате, проверьте схему. Искомая цепь 

обнаружится под другим именем, а вовсе не тем, которое – как он думал! – дал ей схемотех-

ник. 

9.2. Off-Page Connectors. 

Если схема велика, еѐ можно разместить на нескольких листах. Изменим предыдущий 

дизайн следующим образом: добавьте в схему ещѐ один точно такой же лист (рис.  9-9). 

 
рис.  9-9 

Правильно пронумеруйте коннекторы. На рис.  9-10 показан первый лист (Page1), на 

рис.  9-11 – второй лист (Page2). 

 
рис.  9-10 

 
рис.  9-11 

Передайте обновлѐнный netlist в Layout. 

 
рис.  9-12 

На рис.  9-12 показан результат. Обратите внимание, что выводы #2 всех коннекторов 

соединены вместе цепью GND, а выводы #1 – попарно, несмотря на то, что на обоих листах 
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цепь CONN1 имеет одинаковое имя. 

Откройте таблицу Nets в Layout Plus (рис.  9-13): 

 
рис.  9-13 

Layout получил две разные цепи: CONN1 и CONN1_3086. Вот ещѐ один способ оты-

скать скрытую ошибку на схеме: ищите цепи с одинаковыми именами! Если существует две 

или несколько цепей, у которых начало имени совпадает, но к основному имени через сим-

вол подчѐркивания добавлен суффикс, значит, нашѐлся «клон». Возможно,
115

 на схеме име-

ется обрыв! 

Как можно проверить данную ситуацию в Capture? Во-первых, воспользуйтесь инстру-

ментом Design Rule Check. Флаг «Check off-page connector connections» (рис.  9-14) должен 

быть установлен. 

 
рис.  9-14 

На схеме будет создан маркер возможной ошибки (рис.  9-15): 

 
рис.  9-15 

                                                
115 Правило справедливо для дизайнов без иерархии, о чѐм будет сказано ниже. 
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А в Log-файле появится запись, что на схеме существуют цепи, которые имеют одина-

ковое имя, но электрически не соединены: 

Checking Off-Page Connections 

WARNING [DRC0008]   Two nets in same schematic have the same name, but 

there is no off-page connector CONN1:  MAIN, PAGE1  (91.44, 63.50)  

Во-вторых, можно воспользоваться Property Editor. Для этого перейдите в Project 

Manager, выделите дизайн целиком (рис.  9-16), после чего выполните: «Edit → Object Prop-

erties». 

 

рис.  9-16 

Перейдите во вкладку Schematic Nets (рис.  9-17): 

 

рис.  9-17 

Странно. Цепь с именем CONN1_3086 не обнаружена. На схеме только две цепи, а в 

netlist-е – три! 

 

рис.  9-18 

Перейдите во вкладку Flat Nets (рис.  9-18). Здесь мы, наконец, видим, что цепей дейст-

вительно три. 

Смысл понятия «Flat» будет ясен в главе «Построение схем с иерархией. 

С этой главы мы начинаем большую тему, посвящѐнную построению иерархических 

схем в OrCAD Capture. 

Flat Design.», а пока просто запомните, что при наличии в дизайне по какой-либо при-

чине нескольких разных цепей с одинаковым именем, каждая такая цепь будет определена 

как уникальная и получит собственное название, состоящее из начального имени и суффик-

са, что и отражается в данной таблице. 

Касательно цепи GND тоже будет выдано предупреждение: 
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WARNING [DRC0037]   Net has two or more aliases - possible short? GND:  

MAIN, PAGE1  (91.44, 66.04)  

    Alternate Name:  GND_T 

Capture обнаружил, что одна из цепей имеет несколько имѐн. Если это ошибка, то цепи 

будут закорочены. Если же это было сделано Вами сознательно, можете проигнорировать 

данное предупреждение. 

Обратите внимание: если Вы обновляете netlist, то Layout Plus выделяет тѐмно-жѐлтым 

цветом все новые цепи в таблице Nets. 

Для соединения одноимѐнных цепей в пределах одной схемы (Schematic), расположен-

ных на разных листах, как Вы, несомненно, знаете, используются Off-Page Connectors. Из-

менив схему соответствующим образом (рис.  9-19, рис.  9-20), мы устраним проблему. 

 
рис.  9-19 

 
рис.  9-20 

Layout Plus (рис.  9-21): 

 
рис.  9-21 

Nets-таблица (рис.  9-22). 

 
рис.  9-22 

9.3. Global Connections. 

Символы питания и земли в OrCAD Capture имеют статус Global. Это значит, что такие 

символы, если они имеют одинаковое имя, электрически соединены между собой в пределах 

всего дизайна, даже если последний состоит из нескольких листов и схем. Никаких дополни-

тельных соединителей не требуется. 

В библиотеке Capture CAPSYM.OLB имеется набор стандартных символов питания 
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(рис.  9-23) и земли (рис.  9-24). 

 
рис.  9-23 

 
рис.  9-24 

Символы питания имеют видимое имя, что исключает возможность ошибки во время 

проектирования. Например, VCC и VCC_CIRCLE, несмотря на одинаковое начертание, оче-

видно, не будут иметь соединения. Кроме того, изменив имя, можно использовать один и тот 

же символ для обозначения разных цепей (рис.  9-25): 

 
рис.  9-25 

У символов земли имена, как правило, скрыты, что может привести к ошибке. На рис. 

 9-24 имеется два внешне одинаковых символа, имеющих, тем не менее, разные имена: GND 

и GND_POWER. Имя символа можно увидеть в Property Editor. Кроме того, имя можно 

сделать видимым. 

 
рис.  9-26 

Для этого выделите столбец Name и щѐлкните по кнопке <Display…> (рис.  9-26). В 

открывшемся окне поменяйте флаг с «Do Not Display» на «Value Only» (рис.  9-27). 

 
рис.  9-27 

Вот что мы увидим на схеме (рис.  9-28): 

 
рис.  9-28 

Если в дизайне имеется несколько раздельных земель, я бы рекомендовал выводить их 

имена на схему. 

VCC VCC_ARROW VCC_BAR VCC_CIRCLE VCC_WAVE

+5V +3.3V

GND GND_EARTH GND_FIELD SIGNAL GND_POWER GND_SIGNAL
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Статус Global имеют именно символы питания и земли, но никак не цепи! Сейчас мы в 

этом убедимся. Откройте Property Editor и перейдите во вкладку Global (рис.  9-29): 

 
рис.  9-29 

В дизайне имеются четыре global-символа GND_T. Выделите столбец Name, нажмите 

<Ctrl>+<E> и поменяйте имя на GND. Схема примет следующий вид (рис.  9-30, рис.  9-31): 

 
рис.  9-30 

 
рис.  9-31 

Теперь откройте Property Editor и перейдите во вкладку Flat Nets (рис.  9-32). 

 
рис.  9-32 

Имеется две цепи. При этом GND обозначена как Global. 

На одном из листов уберите символы земли (рис.  9-34) и проверьте результат. 

 
рис.  9-33 

 
рис.  9-34 

 

J2

TBx2
PWR-2

1
2

J1

TBx2
PWR-2

1
2

CONN1

GNDGND

GND

CONN1

CONN1

J4

TBx2
PWR-2

1
2

J3

TBx2
PWR-2

1
2 GND GND

CONN1

GNDGND

J2

TBx2
PWR-2

1
2

J1

TBx2
PWR-2

1
2

CONN1

GNDGND

GND

CONN1

CONN1

J4

TBx2
PWR-2

1
2

J3

TBx2
PWR-2

1
2 GND GND

CONN1



No
t f

or
 co

m
m

er
cia

l u
se

.

Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 418 

 
рис.  9-35 

Мы видим, что в дизайне имеется две заданные цепи: CONN1 и GND (рис.  9-35). Од-

нако, цепь GND на первом листе не соединяется с GND на втором листе. Это будет ошибкой. 

 
рис.  9-36 

Если провести аналогию с программированием, то Off-Page Сonnectors являются ло-

кальными переменными, соединяющими цепи в пределах одной Schematic. Символы питания 

и земли, в таком случае – это переменные глобальные. Они «работают» в пределах всего ди-

зайна. 

Таким образом, можно создать свой собственный Global Off-Page Connector, сохранив 

его в пользовательской библиотеке. 

Перейдите в Project Manager и выполните: «File → New → Library». Вот у Вас появи-

лась новая, пока ещѐ пустая, библиотека (рис.  9-37). 

 
рис.  9-37 

Щѐлкните по ней правой кнопкой мыши и выберите New Symbol (рис.  9-38). Задайте 

имя символа и тип: Power. 
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рис.  9-38 

Далее, нарисуйте символ по своему желанию. Например, такой (рис.  9-39): 

 
рис.  9-39 

Тип вывода определите как Passive и укажите его вид (рис.  9-40): 

 
рис.  9-40 

Позаботьтесь, чтобы имя символа было видно на схеме. Для этого выполните: «Op-

tions → Part Properties…», выберите Name, нажмите <Display…> и установите флаг Value 

Only (рис.  9-41). 
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рис.  9-41 

Сохраните символ и только что созданную библиотеку. 

Теперь у Вас есть новый Global Net Connector. Вы можете поместить его на схему, вос-

пользовавшись командой Place Power или Place Ground, предварительно подключив биб-

лиотеку к проекту (рис.  9-42). 

 
рис.  9-42 

Измените схему, как показано на рис.  9-43 и рис.  9-44… 

 
рис.  9-43 

 
рис.  9-44 

… и давайте посмотрим Property Editor. 
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рис.  9-45 

На схеме имеется 4 Global-символа (рис.  9-45). Или, можно сказать, Global Connectors. 

Использовался символ Global () (так мы его назвали в библиотеке). Имена символов: 

CONN1 и GND (). Соответствующее имя получат и подключѐнные к ним цепи. Символы 

расположены на листах PAGE1 и PAGE2 (). 

 
рис.  9-46 

В соответствии со сделанными соединениями, в дизайне имеются не четыре, а только 

две цепи, имена которых соответствуют подключенным Global Connector-ам (рис.  9-46). 

Цепи CONN1 и GND соединяются во всѐм дизайне способом Global (рис.  9-47), поэто-

му не требуют ни Off-Page Connectors для связи в пределах Schematics, ни Hierarchical Ports 

для связи между Schematics
116

. 

 
рис.  9-47 

9.4. Global и Off-Page Connectors. 

Ещѐ одна ошибка, которую легко допустить. Что будет, если подключить Off-Page 

Connector к цепи, соединѐнной с Global? 

                                                
116 О построении иерархических схем в OrCAD Capture будет рассказано чуть ниже. 

1 2 3 
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рис.  9-48  

рис.  9-49 

Измените схему, как показано на рис.  9-48 и рис.  9-49. Теперь сделайте проверку DRC 

и посмотрите отчѐт: 

Reporting Globals 

    GND 

Reporting Net Names 

    CONN1 

    GND 

    GND_3086 

WARNING [DRC0037]   Net has two or more aliases - possible short? GND:  MAIN, 

PAGE1  (243.84, 160.02)  

    Alternate Name:  GND 

Мы видим одно странное предупреждение, что цепь GND имеет второе имя: GND. Имя 

то же самое, но OrCAD разделил цепи, несмотря на то, что GND имеет соединение через 

Global. 

 
рис.  9-50 

Откройте Property Editor (рис.  9-50). Как видно, цепь GND, получив Off-Page Connec-

tor, была «разжалована в рядовые». 

Это следует знать. Если Вы для подстраховки или для ясности добавляете Off-Page 

Connector-ы к Global-цепям, то соединители должны присутствовать на каждом листе. 

Если дизайн состоит из двух листов, то ошибку определить очень легко, поскольку 

Capture сделает предупреждение типа: 

No matching off-page connector GND 

То есть, одному из соединителей не нашлось пары. 

А теперь попробуйте нарисовать схему на трѐх листах и поставить только два соедини-

теля (рис.  9-51). 

Метки  и  имеют предупреждение: 
Checking Off-Page Connections 

WARNING [DRC0008]   Two nets in same schematic have the same name, but there 

is no off-page connector GND:  MAIN, PAGE2  (248.92, 139.70)  

WARNING [DRC0008]   Two nets in same schematic have the same name, but there 

is no off-page connector GND:  MAIN, PAGE3  (246.38, 139.70)  

 

J2

TBx2
PWR-2

1
2

J1

TBx2
PWR-2

1
2

CONN1

J4

TBx2
PWR-2

1
2

J3

TBx2
PWR-2

1
2

CONN1

GND
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рис.  9-51 

Метка : 
WARNING [DRC0037]   Net has two or more aliases - possible short? GND:  MAIN, 

PAGE1  (243.84, 160.02)  

    Alternate Name:  GND 

Вот как это выглядит на плате (рис.  9-52): 

 
рис.  9-52 

Коннекторы J1 и J2 оказались оторванными от остальных. 

Можно попробовать иначе (рис.  9-53): 

1 

3 2 
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рис.  9-53 

Сообщение метки : 
WARNING [DRC0008]   Two nets in same schematic have the same name, but there 

is no off-page connector GND:  MAIN, PAGE3  (246.38, 139.70) 

Метка : 
WARNING [DRC0037]   Net has two or more aliases - possible short? GND:  MAIN, 

PAGE1  (243.84, 160.02)  

    Alternate Name:  GND 

OrCAD Layout (рис.  9-54): 

 
рис.  9-54 

Оторванными оказались коннекторы J5 и J6. 

1 

2 
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9.5. Title Block. 

На каждом листе дизайна должен присутствовать Title Block – штамп, место, в котором 

указывается название проекта, название фирмы и еѐ атрибуты, имя разработчика и прочая 

информация. Title Block в Capture – библиотечный символ. Образцы Title Blocks находятся в 

библиотеке CAPSYM.OLB. 

Кроме того, возможно создавать собственные варианты Title Blocks. На рис.  9-55 пока-

зан один из примеров. 

 
рис.  9-55 

Как видно, Title Block, как правило, изображается  в виде прямоугольной таблицы, в 

ячейках которой может быть произвольная постоянная текстовая или графическая информа-

ция, а также изменяемые поля. Ячейки, информация в которых может изменяться, оформля-

ются в виде Properties. На рис.  9-55 они показаны чѐрным цветом. 

Некоторые Properties Capture модифицирует автоматически: например, номер страни-

цы. Другие предназначены для заполнения пользователем: например, имя проверяющего. 

Некоторые поля можно заполнить ещѐ на стадии создания библиотечного элемента. Напри-

мер, имя разработчика. Незаполненные поля Capture изображает взятыми в треугольные 

скобки. Между скобками выводится название поля: например, <Approved By>. 

Вы можете создать произвольное количество User Properties, которые могут быть по-

том использованы для составления различных отчѐтов. 

В таблице, приведѐнной ниже, перечислены стандартные Properties для Title Block, за-

резервированные OrCAD Capture: 

Property Описание Обновляется 
Capture 

Cage Code Cage Code – пятизначный код-идентификатор фирмы или 
компании, принятый в США. 

Узнать больше о Cage Code можно здесь: 
http://www.dlis.dla.mil/CAGESearch/cage_faq.asp 

А по следующей ссылке можно осуществить поиск компании 
по её Cage Code или по названию: 
https://www.bpn.gov/bincs/begin_search.asp 

 

Design Create Date Дата создания дизайна.  
Design Create Time Время создания дизайна.  
Design File Name Имя файла дизайна и путь к нему.  
Design Modify Date Дата последней модификации дизайна.  

http://www.dlis.dla.mil/CAGESearch/cage_faq.asp
https://www.bpn.gov/bincs/begin_search.asp
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Design Modify Time Время последней модификации дизайна.  
Design Name Имя дизайна. То же, что и Design File Name.  
Doc Номер документа.  
Name Заголовок Title Block.  
OrgAddr1 1-я строчка адреса компании.  
OrgAddr2 2-я строчка адреса компании.  
OrgAddr3 3-я строчка адреса компании.  
OrgAddr4 4-я строчка адреса компании.  
OrgName Имя компании.  
Page Count Общее количество листов в дизайне, включая все листы ие-

рархии.  

Page Create Date Дата создания страницы.  
Page Create Time Время создания страницы.  
Page Modify Date Дата последнего изменения страницы.  
Page Modify Time Время последнего изменения страницы.  
Page Number Номер листа.  
Page Size Размер листа. Влияет на установки принтера.  
RevCode Номер ревизии (версии).  
Schematic Create 
Date 

Дата создания схемы (schematic folder). 
 

Schematic Create 
Time 

Время создания схемы (schematic folder). 
 

Schematic Modify 
Date 

Дата последнего изменения схемы (schematic folder). 
 

Schematic Modify 
Time 

Время последнего изменения схемы (schematic folder). 
 

Source Library Имя библиотеки из которой был взят Title Block и путь к ней.  
Schematic Page 
Count 

Количество листов в схеме (schematic folder). 
 

Schematic Page 
Number 

Номер листа в схеме (schematic folder). 
 

Symbol Library Имя Title Block в библиотеке.  
Title Заголовок Title Block. То же, что и Name.  
Path Name Библиотечное название Title Block. Если в дизайне присутст-

вует иерархия, то к названию добавляется путь.  

Schematic Name Имя схемы (schematic folder)  
Schematic Path Иерархический путь к Schematic.  

Properties, отмеченные как , обновляются после операции Annotate. 

Пожалуйста, нарисуйте собственный Title Block, отдалѐнно напоминающий тот, что 

показан на рис.  9-55 и сохраните в своей библиотеке. 
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9.6. Design Cache. 

В главе « 6.11 Cleanup Design.» мы говорили, что OrCAD Layout Plus сохраняет всю 

информацию об используемых компонентах в собственной базе данных, что позволяет сво-

бодно перенести весь дизайн, например, на другой компьютер. OrCAD Capture ведѐт точно 

такую же базу, которая называется Design Cache. 

 
рис.  9-56 

Доступ к Design Cache осуществляется через Project Manager. Наличие кэша делает ди-

зайн не только мобильным, но и даѐт ряд дополнительных возможностей: 

во-1, получив схему, Вы можете редактировать еѐ, даже не имея под рукой библиотек, 

которые были использованы ранее, копируя элементы из кэша; 

во-2, можно скопировать элемент из Cache в собственную библиотеку; 

в-3, скопированный элемент можно отредактировать и… 

в-4, заменить все устаревшие элементы новым сразу во всѐм дизайне. 

Посмотрите на рис.  9-53. Мы использовали для работы Title Block, установленный по 

умолчанию. Давайте поменяем его на новый, который мы только что создали. 

Щелкните правой кнопкой мыши по элементу TitleBlock0 и выберите Replace Cache 

(рис.  9-57). 

 
рис.  9-57 

В окне Replace Cache (рис.  9-58) нажмите кнопку <Browse…> и укажите путь к своей 

библиотеке. После этого выберите из списка созданный недавно Title Block. 



No
t f

or
 co

m
m

er
cia

l u
se

.

Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 428 

 
рис.  9-58 

Переключатель Action имеет два положения: в режиме Preserve schematic part proper-

ties все одноимѐнные свойства элемента, заполненные пользователем, будут унаследованы 

новым символом, а в режиме Replace… – обновлены из библиотеки. 

 
рис.  9-59 

Установите флаг в положение «Replace». 

Title Block на всех страницах будут заменены новым (рис.  9-59). Поправьте их, устано-

вив в угол листа. 

Если Вам понадобится что-то исправить в Вашем штампе, нет необходимости заново 

искать свою библиотеку и заменять полностью старый элемент новым. Отредактируйте сим-

вол в библиотеке, а потом отдайте команду Update Cache (рис.  9-57). Символ обновится. 

Design Cache, подобно Layout Plus Database, «помнит» все элементы, использовавшиеся 

в дизайне. Если это не нужно, Вы можете уменьшить размер файла, очистив кэш командой 

Cleanup Cache (рис.  9-60). 
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рис.  9-60 

9.7. Annotate. 

На рис.  9-59 обратите внимание, что поля Page Number и Page Count остались неза-

полненными. Capture не следит за ними постоянно и обновляет только по запросу командой 

Annotate. 

Как происходит нумерация элементов дизайна? Существует несколько способов, в за-

висимости от настроек мастера (рис.  9-61). 

 Annotate as per PM Ordering. В этом случае сначала будут пронумерованы все 

листы в том порядке, как они представлены в окне Project Manager. После это-

го по порядку нумеруются компоненты дизайна. 

 Do not change the page number. Можно вручную пронумеровать листы. В этом 

случае, компоненты будут пронумерованы, как и ранее, но номера страниц не 

изменятся. 

 Annotate as per page ordering in the title blocks. В этом случае, нумерация ком-

понентов будет произведена в соответствии с номерами страниц. То есть, нач-

нѐтся на первой странице, продолжится на второй и так далее. 

Выполните Annotate с настройками, как показано на рис.  9-61. После этого попробуй-

те пронумеровать листы вручную, и посмотрите, что произойдѐт, если настройки изменить. 

Настройки поля Scope: 

 Update entire design – операция Annotate будет произведена над всеми Schemat-

ic дизайна. 

 Update Selection – обработке подвергнется только тот лист или схема, которая 

выбрана в Project Manager. 

Настройки поля Action: 

 Unconditional reference update – «сплошная» нумерация элементов дизайна. 

Прежние номера будут потеряны. 

 Reset Part references to “?” – очистка property Part Reference для всех компо-

нентов, расположенных на листе или дизайне. 

 Incremental reference update – новые номера получают только элементы, Part 

Reference которых равен «?». 

Последний случай очень удобен, если схему приходилось изменять. 
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рис.  9-61 

Зайдите в: «Options → Preferences… → Miscellaneous » (рис.  9-62). 

 
рис.  9-62 

Обратите внимание на флаг Automatically reference placed parts. Если этот флаг 

сброшен, то все новые компоненты, добавляемые на схему, получат Part Reference со зна-

ком «?». Если флаг установлен, то новый компонент немедленно получит очередной номер. 

Предположим, имеется схема (рис.  9-63), в которой нужно что-то изменить: убрать 

часть элементов и добавить новые. Очень важно при этом сохранить уже существующую 



No
t f

or
 co

m
m

er
cia

l u
se

.

OrCAD 

 Стр. 431 

нумерацию компонентов, чтобы не вносить путаницы в имеющуюся документацию. 

 
рис.  9-63 

Удалим R2 (рис.  9-64): 

 
рис.  9-64 

Добавим новый резистор (рис.  9-65): 

 
рис.  9-65 

Сделаем Annotate в режиме Incremental reference update (рис.  9-66): 

 
рис.  9-66 

Новый резистор получил имя R4, несмотря на то, что имя R2 свободно. 

9.8. Intersheet References. 

Вернѐмся к теме Off-Page Connectors. Off-Page Connectors служат для соединения цепей 

на разных листах в переделах одной схемы (Schematic). Схема может быть достаточно боль-

шой и состоять из десятка или даже более листов. Поэтому удобно было бы около каждого 

соединителя поставить метку, указывающую на каком именно листе цепь продолжается. 

Такую возможность даѐт мастер Annotate, в режиме Add Intersheet References, при 

этом он опирается на информацию поля Page Number из Title Blocks. 

Дополнительные настройки (рис.  9-67): 

R1 R2 R3

R1 R3

R1 R3

R?

R1 R3

R4
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рис.  9-67 

Поле Position указывает на то, как будет расположена метка относительно соедините-

ля. 

 
рис.  9-68 

Format задаѐт способ перечисления номеров страниц: полный или сокращѐнный, если 

номера страниц следуют по порядку. 
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Prefix и Suffix позволяют добавить в метку произвольный текст. 

На рис.  9-68 показано, что получится в результате. 

Для схем, не содержащих иерархии допустимо вместо Off-Page Connectors использо-

вание соединителей типа Port. Это удобно, если важно указать не просто соединение цепи 

между всеми листами, а проследить распространение сигнала, поскольку Port-соединители 

имеют атрибут Type, указывающий на их функциональное назначение. Type может быть ра-

вен значению Input, Output, Bidirectional, Passive и т.д.. 

Поле Port Type Match Matrix задаѐт соответствие межстраничных соединителей со-

гласно их типу. Таким образом, метка порта Output будет указывать на все порты Input, и на-

оборот (рис.  9-69). 

 
рис.  9-69 

  

 

 
 




